
MODULE 9: ROLE TAILORING 

Module Overview 
In Microsoft Dynamics NAV 2013, the RoleTailored user interface design gives 
users a quick overview of the information that is relevant to their job and enables 
them to focus on their own tasks. At the core of the RoleTailored user interface is 
the Role Center. This is the main entry point into the application for every user. 

The primary goal of a Role Center is to increase user productivity. A Role Center 
maps to the user’s role in the organization. It provides access to those functions 
and features that relate to the role, and hides any rarely used functions or 
features. Microsoft Dynamics NAV 2013 has more than 20 Role Centers. Each Role 
Center is represented by a page object. 

When you develop custom application areas for Microsoft Dynamics NAV 2013, 
you must provide new Role Centers for any roles that are not represented in the 
default set. Or you must customize existing Role Centers to provide access to the 
new functions or features that you introduced. 

Objectives 
• Define the components of the RoleTailored user interface. 

• Explain the structure, purpose, and functionality of a Role Center-type 
page. 

• Create the Seminar Manager Role Center page. 

• Describe the functionality of the Departments page and the 
MenuSuite object type. 

• Integrate the Seminar Management department into the 
Departments page. 
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Prerequisite Knowledge 
Microsoft Dynamics NAV 2013 supports more than 20 default roles with a default 
installation. Those roles combine the functionality of the application areas that are 
available in the standard application. When you create new application areas or 
customize existing ones, you may have to provide new Role Centers for any user 
roles that are not included in the default set. Or you may have to integrate any 
new pages into relevant existing Role Centers to give users access to frequently 
used features. 

A Role Center is a composite page that consists of the following: 

• Other pages, such as activities and lists 

• System parts, such as notifications or Outlook 

• Definitions of the actions in the ribbon 

• Definition of the navigation pane and its contents 

RoleTailored User Interface Overview 

The RoleTailored user interface design gives users a quick overview of the 
information that is relevant to their job. This design paradigm enables users to do 
the following: 

• Focus, prioritize, and apply their expertise quickly and efficiently. 

• Visualize and understand key data. 

• Reduce the time that is spent searching for functionality and data. 

Research shows that the greatest challenges to users are frequent interruptions 
and balancing multiple concurrent tasks. Microsoft Dynamics NAV 2013 helps 
resolve this issue with a RoleTailored design that is combined with a familiar and 
easy-to-use interface. Instead of mapping to the structure of the database, the 
RoleTailored user interface maps to the tasks that a role must perform. This role-
based navigation reduces complexity by promoting areas of the application that 
are relevant to each role. Role-based navigation reduces the information that 
users must understand. It does this by removing application areas that users rarely 
access. 

Role Center 

The Role Center links users to the processes in which they participate. By exposing 
the most frequently used functions in a single location, a Role Center serves as the 
entry point for every user. It enables users to focus on their tasks, without 
spending unnecessary time locating features in the user interface. 
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The Order Processor Role Center is a typical example of a Role Center. It provides 
salespeople with quick access to different types of sales documents and allows 
them to easily access and manage important information, such as customers, 
items, or notifications. 

 

FIGURE 9.1: ORDER PROCESSOR ROLE CENTER 

The components of a Role Center are as follows: 

1. Ribbon 
2. Navigation pane 

3. Role center area 

You define all these components in a page of type RoleCenter by using the Page 
Designer window. The role center area is the main area of a Role Center page, 
and replaces the content area that all other page types have. 

The “Page 9006, Order Processor Role Center” image shows the components of 
the Order Processor Role Center page in Page Designer. 
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FIGURE 9.2: PAGE 9006, ORDER PROCESSOR ROLE CENTER 

    Note: You cannot write any trigger code on pages of type RoleCenter. This 
applies not only to page triggers, such as OnOpenPage or OnClosePage, but also to 
action triggers. Any action that is defined in a Role Center page may only use the 
RunObject property. Any code in the triggers prevents you from compiling or saving 
the page. 

Actions and Ribbon 

Actions let users access features of an application, such as a List Place, or run a 
function, such as posting an invoice. The ribbon organizes action types into tabs 
and groups for quick and easy access by users. The ribbon is available from most 
page types. 

The “Ribbon” image shows the ribbon for the Customer List page, and it shows 
the Home, Actions, Navigate, and Report tabs, and New, Manage, Process, 
Report, View, and Show Attached groups. 

 

FIGURE 9.3: THE RIBBON 

For each page, you define all actions in the Action Designer. This includes the 
contents of the ribbon. For pages of type RoleCenter, you also use Action 
Designer to define the contents of the navigation pane. 

You define where an action is shown in the user interface by using different action 
container types. This is how different action container types map to elements of 
the RoleTailored user interface. 
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Action Container Type  RoleTailored Client Element 

NewDocumentItems Actions tab, New Document group 

ActionItems Actions tab 

RelatedInformation Navigate tab 

Reports Report tab 

HomeItems Home menu of the Navigation pane  

ActivityButtons Other menus of the Navigation 
pane, such as Posted Documents 

    Note: If an action container of type ActionItems, RelatedInformation or 
Reports contains action groups, these groups appear as separate group in the 
Actions, Navigate and Report tabs. Any actions that do not belong to an action 
group and are defined at the action container level, appear in the General group of 
the appropriate tab. 

When you define actions in the HomeItems or ActivityButtons action containers in 
the Role Center page, the following actions appear in the navigation pane for any 
user who belongs to a profile that uses this Role Center page: 

• Actions in the HomeItems action container appear in the Home 
menu, and you cannot group these actions into action groups. 

• Actions in the ActivityButtons action container are displayed as 
separate menus. You must group these actions into action groups. 
Every action group is listed as a separate menu in the navigation 
pane. 

In addition to the Home menu, the navigation pane for the production planner 
profile includes Journals, Worksheets, Product Design, and Capacities menus. 
Each of these additional menus is defined as an action group in the 
ActivityButtons action container in page 9010, Production Planner Role Center. 
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FIGURE 9.4: NAVIGATION PANE FOR THE PRODUCTION PLANNER 
PROFILE 

Activities 

Every Role Center includes the Activities part that contains stacks of documents. 
These are known as cues. A cue visually shows the number of documents of a 
specific type that exists in the application. Cues also let users quickly access the list 
of documents with an appropriate filter applied. For example, if a cue shows the 
number of released sales orders, and a user clicks the cue, the list of released sales 
orders is displayed. 
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The Activities part is defined as a CardPart page, and uses groups of type 
CueGroup to show the cues. Every cue is defined as a field in the source table of 
the Activities page. 

CueGroup is the only control type in Microsoft Dynamics NAV 2013 that lets you 
define control actions. Any control action that is defined on a CueGroup is 
displayed as a link on the right side of the cues. 

Page 9060, SO Processor Activities is an example of an activities page. It includes 
three CueGroups that are named as follows: For Release, Sales Orders Released 
Not Shipped, and Returns. Each group contains actions. For example, the For 
Release group includes the New Sales Quote and New Sales Order actions. 

 

FIGURE 9.5: PAGE 9060, SO PROCESSOR ACTIVITIES 

A field must be of type Integer to correctly show as a cue. If there is no record in 
the source table, the Activities page inserts one. 

The source table of the Activities pages has the following characteristics: 

• It is always named after the functional area, and ends with the word 
Cue. Examples are Sales Cue, Finance Cue, or Purchase Cue. 

• It can only contain a single record. 
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• It has the primary key that has a single field that is named Primary 

Key. 

• Every cue is defined as an integer field of FlowField class and it uses 
the Count method. 

Lists 

Role Centers may contain one or more lists, such as customers, vendors, or items. 
These lists are defined as page parts. Each page is defined as a ListPart page. The 
caption of each list is preceded by the word “my," so that the lists are displayed as 
My Customers, My Vendors, or My Items. 

The Order Processor Role Center page includes the My Customers and My 
Items lists. 

FIGURE 9.6: LISTS IN THE ORDER PROCESSOR ROLE CENTER 

When a Role Center contains such a list, the system automatically shows the 
Manage List action. This lets users select the records to show in the list. Every user 
can decide which records, such as customers or vendors, to include in the list. The 
list is different for each user, and users manage their own lists independently. 

To manage the lists for different users, every list page uses the source table that 
has the following characteristics: 

• It is named after the record type of the list, preceded by the word 
“my." Examples of source tables for list pages are My Customer, My 
Vendor, and My Item. The name is always singular. 
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• It contains only two fields: User ID that specifies to which user the 

record belongs, and another field that relates to the specific record of 
the type that list page shows. For example, the My Customer table 
contains the Customer No. field. 

• Its primary key always contains both fields. 

When a list page is opened, the OnOpenPage trigger sets the range on the User 
ID field to the current user. This guarantees that the page only shows the records 
that belong to the current user. When a new record is inserted in the page, the 
User ID field is automatically populated with the ID of the current user. 

Each list page must include an action named Open that opens the appropriate 
page for managing the record type that is shown in the list. For example, clicking 
Open in the My Customer list opens the Customer Card page. 

Charts 

Charts are graphical representations of business data combinations that you can 
view in list places, FactBoxes, and Role Centers. A Role Center may contain one or 
more charts that display information that is relevant to a profile. 

The “SO per Location Chart” figure shows a chart that users can add to their Role 
Centers. 

 

FIGURE 9.7: THE SO PER LOCATION CHART 

Charts are not defined as objects in the development environment, but as records 
in the Chart table. To access the list of available charts, click Departments > 
Administration > Application Setup > RoleTailored Client > Charts. You 
create charts by defining data and chart properties in the Generic Chart Setup 
page. 

The “Generic Card Setup Page” figure shows the SO per Location chart in the 
Generic Chart Setup page. 
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FIGURE 9.8: GENERIC CARD SETUP PAGE 

Profiles 

Profiles link Role Centers to users and align with the roles and responsibilities that 
users have in an organization. 

To manage profiles, click Departments > Administration > Application Setup 
> RoleTailored Client > Profiles. 

Use the Profiles page for an overview of all profiles. 
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FIGURE 9.9: PROFILES LIST WINDOW 

Use the Profile Card page to create new profiles or change existing ones. 
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FIGURE 9.10: SALES ORDER PROFILE IN THE PROFILE CARD PAGE 

Seminar Manager Role Center 
Managing seminars and seminar registrations is a core process of CRONUS 
International Ltd. There are many employees in their organization who manage 
seminar information, organize new seminars, manage instructors and rooms, and 
perform other seminar-related activities. 

To enable CRONUS employees to be as productive as possible, you must provide 
a Role Center that makes the most frequently used features available to users in as 
few clicks as possible, and hides any unnecessary information. 

Solution Design 

CRONUS International Ltd. functional requirements do not specifically mention 
Role Center functionality. However, there is a nonfunctional requirement that the 
solution must let users be as productive as possible by reducing the amount of 
searching and filtering. 

Role Centers are one of the core productivity features of Microsoft Dynamics NAV 
2013. It aligns with the following goals of the nonfunctional requirement: 

• It helps users be as productive as possible. 

• It significantly reduces time that is spent searching features. 

• It significantly reduces time that is spent filtering lists. 
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To provide a consistent user experience with other application areas, you must 
provide a Seminar Role Center page that includes all features that are typically 
found on Role Centers. These features let users quickly enter and process 
information. 

At a minimum, the Seminar Manager Role Center page must contain the 
following features: 

• Include the Activities part with cues that indicate the number of 
documents in various statuses. 

• Include the My Seminars and My Customers lists. 

• Include links in the Home menu to enable users to access master data 
(seminars, instructors, rooms, customers, and contacts) and 
documents (registrations). 

• Include the Posted Documents menu to enable users to access 
posted information for seminars. 

• Enable users to create new seminar registration and invoice 
documents directly from the Role Center. 

• Enable users to run the invoice creation batch job. 

• Enable users to run the Navigate page. 

• Enable users to print the Participant List report. 

Development 

A Role Center is not a single page object. It depends on several other objects, 
including pages and tables, to provide users with familiar functionality. 

Tables 

To enable the Role Center functionality, you must create the following tables. 

Table Remarks 

123456740 Seminar Cue Contains the flow fields for the cues on the 
Activities page part of the Role Center page. 

123456741 My Seminar Contains the list of seminars that each user 
has included in the My Seminars list. 

Pages 

You must create the following pages: 

Page Remarks 

123456740 Seminar Manager Role 
Center 

The Role Center page. 
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Page Remarks 

123456741 Seminar Manager 
Activities 

The Activities page part for the Role 
Center page. 

123456742 My Seminars A list part for the Role Center page 
that lets users manage their list of 
favorite seminars. 

The “Seminar Manager Role Center” figure shows the Seminar Manager Role 
Center with all its components. 

 

FIGURE 9.11: SEMINAR MANAGER ROLE CENTER 
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Lab 9.1: Create the Seminar Manager Role Center 
Scenario 

You are a developer at the company that is implementing Microsoft Dynamics 
NAV 2013 for CRONUS International Ltd. Your task is to develop the Role Center 
page for the Seminar Manager role. The Role Center page must contain the 
functionality that is normally found in a Microsoft Dynamics NAV 2013 Role 
Center page. 

Exercise 1: Seminar Activity Page 
Exercise Scenario 

Start by creating the supporting objects. The first supporting object is the 
Activities page that is used as a page part on the Seminar Manager Role Center 
page. The Activities page uses a source table. Therefore, you must first develop 
the table, and then the page. 

Task 1: Create the Cue Table 

High Level Steps 
1. Create the Seminar Cue table.  

2. Set the flow field properties on the appropriate fields to indicate the 
count of planned, registered, and closed seminar registrations. 

Detailed Steps 
1. Create the Seminar Cue table.  

a. Create a new table, and save it as 123456740, Seminar Cue. 
b. Define the following fields in the table. 

Field No. Field Name Data Type Length 

1 Primary Key Code 10 

2 Planned Integer  

3 Registered Integer  

4 Closed Integer  

2. Set the flow field properties on the appropriate fields to indicate the 
count of planned, registered, and closed seminar registrations. 

a. Set the properties on the Planned field to be the flow field, and 
to show the number of seminar registrations in status Planned. 

    Note: Count("Seminar Registration Header" WHERE 
(Status=CONST(Planning))) 
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b. Set the properties on the Registered field to be the flow field, 

and to show the number of seminar registrations in status 
Registration. 

    Note: Count("Seminar Registration Header" WHERE 
(Status=CONST(Registration))) 

c. Set the properties on the Closed field to be the flow field, and to 
show the number of seminar registrations in status Closed. 

    Note: Count("Seminar Registration Header" WHERE (Status=CONST(Closed)))      

d. Compile, save, and then close the table. 

Task 2: Create the Activities Page 

High Level Steps 
1. Create the Seminar Manager Activities page. 
2. Define two cue groups: Registrations and For Posting. 
3. Add fields to cue groups. 
4. Add an action to the Registrations cue group to enable users to 

create new seminar registrations. 
5. Add code to the OnOpenPage trigger to make sure that there is 

always one record in the source table. 

Detailed Steps 
1. Create the Seminar Manager Activities page. 

a. Create a new page for the Seminar Cue table, with the CardPart 
Page Wizard. 

b. Finish the wizard without adding any fields. 
c. Save the page as 123456741, Seminar Manager Activities.  

 

2. Define two cue groups: Registrations and For Posting. 
a. Under the ContentArea container, add the following controls. 

Type SubType Caption 

Group CueGroup Registrations 

Group CueGroup For Posting 

b. Make sure that you indent both cue group controls at the same 
level, which is one level under the parent container. 
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3. Add fields to cue groups. 

a. Add field controls for the Planned and Registered fields to the 
Registrations cue group. 

b. Add field controls for the Closed field to the For Posting cue 
group. 

c. Make sure that all controls are properly indented under their 
parent cue groups. 

The “Page 123456741, Seminar Manager Activities in the Page Designer“ figure 
shows the Page Designer window for the Seminar Manager Activities page, 
with all controls correctly aligned and indented. 

 

FIGURE 9.12: PAGE 123456741, SEMINAR MANAGER ACTIVITIES IN THE PAGE DESIGNER 

d. For each field control (Planned, Registered, and Closed), set the 
DrillDownPageID property to “Seminar Registration List”. 
 

4. Add an action to the Registrations cue group to enable users to 
create new seminar registrations. 
a. Select the Registrations cue group, and then click View > 

Control Actions.  

b. In the CueGroup - ActionDesigner window on the first row, set 
Type to Action, and in the Caption column, enter “New”. 

c. Set the following properties for the New action. 

Property Value 

RunPageMode Create 

RunObject Page Seminar Registration 

5. Add code to the OnOpenPage trigger to make sure that there is 
always one record in the source table. 
a. Open the C/AL Editor for the page. 
b. In the OnOpenPage trigger, enter the following code. 
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RESET; 

IF NOT GET THEN BEGIN 

  INIT; 

  INSERT; 

END; 

c. Compile, save, and then close the page. 

Exercise 2: My Seminars Page 
Exercise Scenario 

The next supporting Role Center object is the My Seminars page. This page also 
uses a source table. Therefore, before developing the page, you must first develop 
the underlying table. After you create the My Seminar table, you create the My 
Seminars page. 

Task 1: Create the My Seminar Table 

High Level Steps 
1. Create the My Seminar table. 
2. Define table relations on fields. 

3. Define the appropriate primary key for the My Seminar table. 

Detailed Steps 
1. Create the My Seminar table. 

a. Create a new table, and save it as 123456741, My Seminar. 
b. Define the following fields in the table. 

Field No. Field Name Data Type Length 

1 User ID Code 50 

2 Seminar No. Code 20 

2. Define table relations on fields. 
a. On the User ID field, set the TableRelation property to User."User 

Name". 

b. On the Seminar No. field, set the TableRelation property to 
“Seminar”. 
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3. Define the appropriate primary key for the My Seminar table. 

a. Click View > Keys. 

b. In the Key column, enter “User ID,Seminar No.” 
c. Compile, save, and then close the table. 

Task 2: Create the My Seminars Page 

High Level Steps 
1. Create the My Seminars page. The page must show only records that 

belong to the current user. 

2. Define a variable for the Seminar table, and add more fields from the 
Seminar table to the My Seminars page. 

3. Enter code in appropriate triggers to make sure that the Seminar 
record always points to the record that is specified in the Seminar 
No. field of the current My Seminar record. 

4. Add the OpenSeminarCard function to run the Seminar Card page 
for the current record. 

5. Define an action to run the OpenSeminarCard function. 

Detailed Steps 
1. Create the My Seminars page. The page must show only records that 

belong to the current user. 

a. Create a new page for the My Seminar table, with the ListPart 
Page Wizard. 

b. Add the Seminar No. field by using the wizard, and finish the 
wizard. 

c. In the OnOpenPage trigger, enter the following code. 

SETRANGE("User ID",USERID); 

d. Save the page as 123456742, My Seminars.  
 

2. Define a variable for the Seminar table, and add more fields from the 
Seminar table to the My Seminars page. 
a. Define a new global variable of type Record for the Seminar 

table, and name it Seminar. 
b. Under the Seminar No. field control, add the following controls. 

Type SourceExpr Name Caption 

Field Seminar.Name <Control4> Name 

Field Seminar."Seminar 
Duration" 

<Control5> Duration 

Field Seminar."Seminar 
Price" 

<Control6> Price 
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The “Page 123456742, My Seminars“ figure shows the Page Designer window for 
the My Seminars page with all controls correctly aligned and indented. 

 

FIGURE 9.13: PAGE 123456742, MY SEMINARS 

3. Enter code in appropriate triggers to make sure that the Seminar 
record always points to the record that is specified in the Seminar 
No. field of the current My Seminar record. 
a. In the C/AL Globals window, define a new function, and name it 

GetSeminar. The function does not receive parameters. 
b. In the function trigger for the GetSeminar function, enter the 

following code. 

CLEAR(Seminar); 

IF Seminar.GET("Seminar No.") THEN; 

c. In the OnAfterGetRecord trigger, enter the following code. 

GetSeminar; 

d. Enter the same code in the OnValidate trigger of the Seminar No. 
field control. 

e. In the OnNewRecord trigger, enter the following code. 

CLEAR(Seminar); 

4. Add the OpenSeminarCard function to run the Seminar Card page 
for the current record. 
a. In the C/AL Globals window, define a new function, and name it 

OpenSeminarCard. The function does not receive parameters. 
b. In the function trigger for the OpenSeminarCard function, enter 

the following code. 
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IF Seminar.GET("Seminar No.") THEN 

  PAGE.RUN(PAGE::"Seminar Card",Seminar); 

5. Define an action to run the OpenSeminarCard function. 
a. Show the Actions Designer for page actions. 
b. In the SubType column, select ActionItems. 
c. On the new row, in the Caption column, enter “Open.” 

The “Action Designer for the My Seminars Page“ figure shows how the Action 
Designer should look now. 

 

FIGURE 9.14: ACTION DESIGNER FOR THE MY SEMINARS PAGE 

d. On the Open action, define the following properties. 

Property Value 

Image Edit 

ShortCutKey Return 

e. In the OnAction trigger for the Open action, enter the following 
code. 

OpenSeminarCard; 

f. Compile, save, and then close the page. 
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Exercise 3: The Role Center Page 
Exercise Scenario 

After you have completed development of all supporting tables and pages, you 
are ready to define the Seminar Manager Role Center page. For this page, you 
must design the page layout, and arrange various page parts in a manner that is 
consistent with standard Microsoft Dynamics NAV 2013 Role Center pages. Then 
you must define the navigation pane elements. This includes the Home items and 
any additional menus. Finally, you must define the ribbon actions for the Role 
Center page. 

Task 1: Create the Seminar Manager Role Center Page 

High Level Steps 
1. Create the Seminar Manager Role Center page. 

2. Add relevant controls to the Seminar Manager Role Center page. 

Detailed Steps 
1. Create the Seminar Manager Role Center page. 

a. Create a new page of type RoleCenter. 
b. Save the page as 123456740, Seminar Manager Role Center. 

 
2. Add relevant controls to the Seminar Manager Role Center page. 

a. Add two group controls, and then indent them one level under 
the RoleCenterArea control. 

b. To the first group, add a page part and a system part control. 
c. For the page part control, set properties to show the Seminar 

Manager Activities page.  

    Note: Set the PagePartID property. 

d. For the system part control, set properties to show the Outlook 
part. 

    Note: Set the SystemPartID property. 

e. To the second group, add the following part controls. 

SubType Part ID 

Page My Seminars 

Page My Customers 

Page Connect Online 
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SubType Part ID 

System MyNotes 

f. For the Connect Online part, set the Visible property to FALSE. 

The “Page 123456740 Seminar Manager Role Center in Page Designer" figure 
shows the Seminar Manager Role Center page in the Page Designer window. 

 

FIGURE 9.15: PAGE 123456740 SEMINAR MANAGER ROLE CENTER IN PAGE DESIGNER 

g. Save the page. 

Task 2: Add Home Items 

High Level Steps 
1. Define actions for home items to include list pages for relevant 

Seminar Management pages. 

Detailed Steps 
1. Define actions for home items to include list pages for relevant 

Seminar Management pages. 
a. Access the Action Designer for the Seminar Manager Role 

Center page actions. 

b. Define a HomeItems container. 
c. Add the following actions to the HomeItems container. 

Caption RunObject 

Seminar Registrations Page Seminar Registration List 

Seminars Page Seminar List 

Instructors Page Resource List 

Rooms Page Resource List

Customers Page Customer List 

Contacts Page Contact List 
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d. For the Instructors action, set the RunPageView property to 

“WHERE(Type=CONST(Person))”. 

e. For the Rooms action, set the RunPageView property to 
“WHERE(Type=CONST(Machine))”. 

f. Save the page. 

Task 3: Add Activity Buttons 

High Level Steps 
1. Add the Posted Documents activity button. 

2. Add page links for posted documents to the Posted Documents 
activity button. 

Detailed Steps 
1. Add the Posted Documents activity button. 

a. In the Action Designer window for the Seminar Manager Role 
Center page, define a new action container of type 
ActivityButtons. 

b. Under the ActivityButtons container, add an action group, and set 
its caption to “Posted Documents”. 

c. On the Posted Documents action group, set the Image property 
to “RegisteredDocs”. 
 

2. Add page links for posted documents to the Posted Documents 
activity button. 
a. Under the Posted Documents action group, add the following 

actions. 

Caption RunObject 

Posted Seminar Registrations Page Posted Seminar Reg. List 

Posted Sales Invoices Page Posted Sales Invoices 

Registers Page Seminar Registers 

Task 4: Add Ribbon Actions 

High Level Steps 
1. Define actions to appear in the New Document group of the ribbon 

on the Seminar Manager Role Center page. 

2. Define actions to appear in the General group of the ribbon on the 
Seminar Manager Role Center page. 

3. Define an action for the Report tab of the ribbon on the Seminar 
Manager Role Center page. 
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Detailed Steps 

1. Define actions to appear in the New Document group of the ribbon 
on the Seminar Manager Role Center page. 
a. In the Action Designer window for the Seminar Manager Role 

Center page, define a new action container of type 
NewDocumentItems. 

b. Under the NewDocumentItems container, add the following 
actions. 

Caption RunObject Image 

Seminar Registration Page Seminar Registration NewTimesheet 

Sales Invoice Page Sales Invoice NewInvoice 

c. For both actions, set the RunPageMode property to Create. 
 

2. Define actions to appear in the General group of the ribbon on the 
Seminar Manager Role Center page. 
a. In the Action Designer window for the Seminar Manager Role 

Center page, define a new action container of type ActionItems. 

b. Under the ActionItems container, add the following actions. 

Caption RunObject Image 

Create Invoices Report Create Seminar 
Invoices 

CreateJobSalesInvoice 

Navigate Page Navigate Navigate 

3. Define an action for the Report tab of the ribbon on the Seminar 
Manager Role Center page. 

a. In the Action Designer window for the Seminar Manager Role 
Center page, define a new action container of type Reports. 

b. Under the Reports container, do the following: 
 Add an action. 

 Set its caption to “Participant List”.  

 Set its RunObject property to “Report Seminar Reg.-
Participant list”. 

 Set its Image property to “Report”. 
 

c. Compile, save, and then close the page. 
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Task 5: Define a Profile for the Seminar Manager 

High Level Steps 
1. In the Microsoft Dynamics NAV 2013 client for Windows, define a 

new profile and configure it for use in the Seminar Manager Role 
Center page. 

Detailed Steps 
1. In the Microsoft Dynamics NAV 2013 client for Windows, define a 

new profile and configure it for use in the Seminar Manager Role 
Center page. 
a. Start Microsoft Dynamics NAV 2013 client for Windows. 
b. In the Search text box, enter “Profiles”. 

c. In the search results, click Profiles. 

    Note: Or, browse to Departments > Administration > Application Setup 
> RoleTailored Client > Profiles. 

d. Click New. 
e. In the New – Profile Card window, enter the following 

information. 

Field Value 

Profile ID SEMINAR MANAGER 

Description Seminar Manager 

Role Center ID 123456740 

f. Select the Default Role Center check box.  

The “Seminar Manager Profile Card“ figure shows the Profile Card page for the 
Seminar Manager profile. 
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FIGURE 9.16: SEMINAR MANAGER PROFILE CARD 

g. Restart the Microsoft Dynamics NAV 2013 client for Windows. 

MenuSuite Object Type 
In Microsoft Dynamics NAV 2013, you can create MenuSuite objects. These 
objects contain menu content that is displayed in department pages of the 
Microsoft Dynamics NAV 2013 client for Windows. The MenuSuite object that is 
provided in Microsoft Dynamics NAV is a basic MenuSuite object that you can 
change. You can also create new MenuSuite objects from the basic MenuSuite 
object. Each menu in the basic MenuSuite represents a department such as 
Financial Management, Jobs, and Manufacturing. Each department contains menu 
items that are specific to that department area. 

Fundamentals 

A MenuSuite is a set of menus, groups, and menu items. Each menu contains 
content for a specific application area, such as Financial Management, Jobs, or 
Manufacturing. You design MenuSuites in the Navigation Pane Designer in the 
Microsoft Dynamics NAV 2013 Development Environment.  

A MenuSuite object has the following characteristics: 

• It consists of a set of menus.  

• A menu contains a collection of menu nodes, which are displayed in 
the Departments page.  
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• It is organized in a tree structure.  

• A menu node can be either a group or a menu item.  

• A menu node has a Globally Unique Identifier (GUID) and other 
properties.  

• A group contains a collection of menu nodes.  

• A menu item is the lowest level in the tree. When you click a menu 
item, its associated application object runs. 

Design Levels 

For each MenuSuite object that you create, you select a design level. Design levels 
are permissions that allow different roles to create MenuSuite objects for specific 
functions. The design level that you can work in depends on your active license. In 
other words, you can only design MenuSuite objects or create MenuSuites that 
your active license and permissions allow. For example, if your active license 
enables you to localize and you design an application that will be localized, your 
design level is at the Country or Region level. If you are a developer working at a 
Microsoft Certified Partner, you might design a MenuSuite object at the Partner 
level. 

Unlike any other application objects, the ID and Name properties of a MenuSuite 
object are determined by the development environment depending on the design 
level. The following table shows the predefined MenuSuite IDs and their 
corresponding levels. 

ID Level Remarks 

1010 Dept – MBS The base MenuSuite object that 
is defined by Microsoft. It defines 
the default Departments menu 
of standard Microsoft Dynamics 
NAV 2013, and it includes all W1 
(worldwide) version objects. This 
object is the same for all local 
versions of Microsoft Dynamics 
NAV 2013. 
Any MenuSuite that you create 
inherits from this base design 
level or a design level that is 
inherited from this base design 
level. 
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ID Level Remarks 

1020 Dept – Region Includes menus that are defined 
by Microsoft for any non-W1 
functionality that is provided for 
a specific region. There is no 
strict definition of a region, and 
MenuSuite 1020 is not 
necessarily present in all 
localized versions. Regional 
functionality may include some 
specific functions or features that 
are the same for several 
countries. They otherwise have 
different local functionality. 

1030 Dept – Country Includes menus for any local 
functionality that is specific to a 
single country. This MenuSuite is 
typically defined by Microsoft or 
another party that is officially 
authorized to develop 
localizations. 

1051..1060 Dept – Add-on Includes menus for any ISV 
solutions or third-party add-on 
modules that your application 
uses. This MenuSuite is typically 
defined by the partner company 
that implements the add-on 
solution for its customer. There 
may be up to ten add-on 
MenuSuite objects. 

1080 Dept – Partner Includes menus for any 
customizations that are provided 
by a single partner that this 
partner reuses at multiple 
company deployments of 
Microsoft Dynamics NAV 2013. 

1090 Dept – Company Includes menus for any 
customizations that are provided 
for a single customer company, 
such as CRONUS International 
Ltd. 

You determine the design level of a MenuSuite at the same time that you create 
it. When you save a MenuSuite, its design level is embedded in its ID and Name 
properties. 
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The Design Level window shows you the list of levels. You must select the level 
for the new MenuSuite. 

 

FIGURE 9.17: THE DESIGN LEVEL WINDOW 

When you create a MenuSuite object, it inherits from the design level that is 
above the level that you selected. For example, if you design at the Region level, 
your MenuSuite object inherits all menus and menu items from the Dept - MBS 
level. Changes that you make to a MenuSuite object that you create are stored as 
the differences between the MenuSuite object at the Dept - MBS level and the 
Dept - Region level. The most basic design level is the Dept - MBS level. The 
highest design level is the Dept - Company level. You can create only one 
MenuSuite object for each level in an application. The Add-on level is the 
exception. It can have no more than ten instances of MenuSuite objects. At design 
time, the header area of Navigation Pane Designer displays the design level of the 
MenuSuite object. 
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Create and Design MenuSuites 

Every new MenuSuite object that you create is designed at one of the design 
levels. If the Dept - MBS MenuSuite is the only MenuSuite in Object Designer, the 
MenuSuite object that you create inherits from the base 1010 Dept - MBS 
MenuSuite object. If there are other MenuSuite objects in Object Designer, the 
new MenuSuite inherits from one of the MenuSuite objects in Object Designer. 
The new MenuSuite object inherits from the MenuSuite object in the design level 
that is above the design level that you selected for the new MenuSuite object. 

To create a new MenuSuite in the Object Designer, click MenuSuite, and then 
click New. To design an existing MenuSuite, select it, and then click Design. 

    Note: You can only have one Navigation Pane Designer open at the same 
time. Before you can create a new MenuSuite or edit another one, first make sure 
that the Navigation Pane Designer is closed. 

Menus 

Menus in the Navigation Pane Designer correspond to departments in the 
Departments menu. In the Navigation Pane Designer, each menu is displayed as 
a menu button with an icon and a caption. When you design MenuSuites, the 
Navigation Pane Designer header indicates the design level and the name of the 
menu that you are currently designing. 

The “Navigation Pane Designer” image shows the Navigation Pane Designer for 
the Financial Management menu in the Company design level. 
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FIGURE 9.18: NAVIGATION PANE DESIGNER 

Manage menus in the Navigation Pane Designer by right-clicking any of the 
existing menus, and then clicking any of the available options. 

The “Managing Menus in the Navigation Pane Designer” image shows the 
shortcut menu in the Navigation Pane Designer after right-clicking any of the 
menus. 
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FIGURE 9.19: MANAGING MENUS IN THE NAVIGATION PANE 
DESIGNER 

The following table explains the available options. 

Option Remarks 

Create Menu… Creates a new menu. 

Delete Deletes the selected menu. 

Rename Changes the caption of the selected menu. 

Move Up / Down Moves the selected menu up or down. Only 
the options that you can click are displayed. 

Hide in Designer Hides the menu from the Navigation Pane 
Designer. This does not hide the department 
from the Departments menu. 

Show in Designer… Shows the list of all hidden menus and lets 
you display the menus that you select. 
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Option Remarks 

Properties Displays the properties for the menu. The 
properties include the Caption, CaptionML, 
and the Bitmap. The Bitmap property 
defines the icon that is shown next to the 
department in the Departments menu. 
Valid values for it are 0 to 15. 

    Note: The Disable and Assign Users options are obsolete in Microsoft 
Dynamics NAV 2013 and have no effect. 

In the list of menu buttons, all menus (departments) that are inherited have the » 
symbol on the menu button. This symbol comes in front of the name of the menu 
on the menu button. Any menus that you created at the current design level do 
not have this symbol. 

The “Seminar Management Menu” image shows the Navigation Pane Designer 
with the new Seminar Management menu that was created at the Company 
design level. The Seminar Management menu does not show the » symbol on 
the menu button to the left of the icon, whereas all other menus do. 
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FIGURE 9.20: SEMINAR MANAGEMENT MENU 

Groups and Items 

You can create groups and items in a menu. Groups are categories of items and 
they define the navigation hierarchy. Items are actions that users can click. Items 
run different application objects. 

To manage groups or items, right-click the Navigation Pane Designer anywhere in 
the design area below the header. 

The “Managing Menus in the Navigation Pane Designer” image shows the 
shortcut menu in the Navigation Pane Designer after you right-click any groups or 
items, or if you right-click in the blank design area below the header. 
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FIGURE 9.21: MANAGING MENUS IN THE NAVIGATION PANE 
DESIGNER 

The following table explains the options. 

Option Remarks 

Create Item… Opens the Create Item window where you 
can define the item properties for a new 
item. 

Insert Items… Opens the Insert Items window where you 
can select from existing items in other 
menus. You can add items as a copy in the 
current group in the current menu. 

Create Group Creates a new group. 

Delete Deletes the currently highlighted item or 
group. 
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Option Remarks 

Properties Shows the Item Properties window that 
lets you define item properties. 

The Create Item and Item Properties windows let you define the same 
information for an item. 

The “Item Properties” image shows the Item Properties window. 

 

FIGURE 9.22: ITEM PROPERTIES WINDOW 

You can define the following properties for each item. 

Property Remarks 

Object Type The type of the object that the item runs. 
It can be one of the following: 

• Report 

• XMLport 

• Codeunit 

• Page 

• Query 

 

Object ID The ID or name of the object that the item 
runs. You can look up the object or enter 
its ID or name manually. 

Caption The caption of the object in the currently 
active language. The caption is suggested 
automatically when you select the Object 
ID. However, you can later change it. 
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Property Remarks 

CaptionML The multilanguage caption of the object. 
Similar to the Caption, it is suggested 
automatically. However, you can change 
it. 

Department The department category where the item 
appears in a Department page, and also 
the icon that is shown with the item in the 
search results when you use the Search 
field. It can have one of the following 
values: 

• Lists 

• Tasks 

• Reports and Analysis 

• Documents 

• History 

• Administration 

 

The “Departments” image shows the Departments page. There are menus on the 
first level. These menus map to the departments. The first-level groups of each 
department are shown together with the department. You can select by category 
after the list of the departments. Each department's categories are represented by 
the available items that are shown in the list. 
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FIGURE 9.23: DEPARTMENTS WINDOW 

Search 

Microsoft Dynamics NAV 2013 client for Windows lets you search for application 
objects by using the Search field in the upper-right corner of the address bar. 
When you start to type characters in the Search field, a drop-down list shows 
object names that contain the characters that you enter. The drop-down list 
changes as you type more characters. Select the correct object from the list when 
it is displayed.  

The second column in the drop-down list shows the navigation paths to the found 
objects. You can use the navigation to move to the Departments page where 
that page exists. 

The Search feature can find only objects that can be accessed from the navigation 
pane. This includes any actions that are available in the Home menu, any of the 
additional menus (menu buttons) in the Role Center, and any actions in 
Departments. 
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Seminar Management Department Page 
Provide a Role Center for users to work with a new application area as a way to 
increase user productivity. However, the Role Center alone is not the only task that 
is available to improve the user experience with the Microsoft Dynamics NAV 
2013 client for Windows. 

Many users do not belong to the seminar manager role, and use different Role 
Centers than the Seminar Manager Role Center. For example, accountants 
generally use the general ledger functionality, and accounts payable employees 
usually access the purchases and payables application area. However, these users 
may require occasional access to seminar-related information that their role 
centers do not provide. 

To give all users access to the Seminar Management application area, you must 
define the Seminar Management department page. By providing this page, you 
make sure that every user can access the Seminar Management functionality in 
Departments, and that all objects that are related to Seminar Management can be 
accessed by using the Search field. 

Solution Design 

Similar to Role Center functionality, CRONUS International Ltd. functional 
requirements do not explicitly mention departments. However, the following 
nonfunctional requirement applies: The solution must be consistent, user-friendly, 
and easy to learn and to use. Any custom-built functionality must follow the 
standards, principles, and best practices of Microsoft Dynamics NAV 2013, and 
must seamlessly integrate into the standard application. 

If you do not provide a department page for Seminar Management, your solution 
does not meet the goals of this requirement. Therefore, you must develop a new 
MenuSuite object that contains the menu definition for the Seminar 
Management department page. 

Development 

Your goal is to develop the Seminar Management department page that 
integrates in the Departments page in Microsoft Dynamics NAV 2013. To do this, 
you must develop the new Seminar Management menu in a new company-level 
MenuSuite. 
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The “Seminar Management menu in the Navigation Pane Designer” image shows 
the Navigation Pane Designer for the Seminar Management menu. 

 

FIGURE 9.24: SEMINAR MANAGEMENT MENU IN THE NAVIGATION PANE 
DESIGNER 
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The “Seminar Management Department Page” image shows the Seminar 
Management Department page in the Microsoft Dynamics NAV 2013 client for 
Windows. 

 

FIGURE 9.25: SEMINAR MANAGEMENT DEPARTMENT PAGE 
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Lab 9.2: Create Seminar Management Department 
Page 

Scenario 

You must develop the Seminar Management department page to enable users 
to access the Seminar Management application area functionality from the 
Departments page and to make Seminar Management objects available to 
search. 

Exercise 1: Create and Design the MenuSuite 
Exercise Scenario 

To create the Seminar Management department page and make Seminar 
Management objects available to search, you must create a new MenuSuite, and 
then create a new menu with appropriate groups and items. 

Task 1: Create the MenuSuite 

High Level Steps 
1. Create and save a new MenuSuite at the company level. 
2. Add the Seminar Management menu. 

Detailed Steps 
1. Create and save a new MenuSuite at the company level. 

a. In Object Designer, click MenuSuite, and then click New. 
b. In the Design Level window, select the Dept – Company level, 

and then click OK. 
c. Click any of the menu buttons in the Navigation Pane Designer. 
d. On the File menu, click Save. 

 
2. Add the Seminar Management menu. 

a. Right-click any of the menu buttons. 
b. In the shortcut menu, click Create Menu. 

c. In the Create Menu window in the Caption field, enter “Seminar 
Management”, in the Bitmap field, enter “13”, and then click OK. 
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Task 2: Define the Group Hierarchy 

High Level Steps 
1. Define the groups as shown in Figure 9.24.  

Detailed Steps 
1. Define the groups as shown in Figure 9.24.  

a. Right-click the [Empty Menu] item in the Navigation Pane 
Designer, and then click Create Group. 

b. Right-click the New Group, click Rename, and then enter 
“Seminars”. 

c. Expand the Seminars group. 
d. Right-click the [Empty Group] item and then click Create 

Group. 
e. Rename the New Group to Periodic Activities. 
f. Right-click the Seminars group, create a new group, and then 

rename it “Order Processing”. 

g. Expand the Order Processing group, right-click the [Empty 
Group] item, create a new group, and rename it “Reports”. 

h. Right-click the Seminars group, create a new group, and then 
rename it ”History”. 

i. Right-click the Seminars group, create a new group, and then 
rename it “Setup”. 

Task 3: Add Items to Groups 

High Level Steps 
1. Add items to groups as shown in Figure 9.24.  

Detailed Steps 
1. Add items to groups as shown in Figure 9.24.  

a. Under the Seminars group, right-click the Periodic Activities 
group, and then click Create Item. 

b. In the Create Item window, enter the following information. 

Field Value 

Object Type Page 

Object ID Contact List 

Caption Contacts 

Department Lists 

c.  
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d. Click OK to create the new item. 
e. Under Seminars group, create the following two items. 

Object ID Caption Department 

Page Customer List Customers Lists 

Page Seminar List Seminars Lists 

f. Under the Periodic Activities group, right-click the [Empty 
Group] item, and then create the following item. 

Object ID Caption Department 

Report Create 
Seminar Invoices 

Create Invoices Tasks 

g. Under the Order Processing group, create the following items. 

Object ID Caption Department 

Page Seminar 
Registration List 

Seminar Registrations Documents 

Page Sales Invoice 
List 

Sales Invoices Documents 

h. Under the Reports group, create the following item. 

Object ID Caption Department 

Report Seminar Reg.-
Participant list 

Participant List Reports and Analysis 

i. Under the History group, create the following items. 

Object ID Caption Department 

Page Posted Seminar 
Reg. List 

Seminar Registrations History 

Page Posted Sales 
Invoices 

Posted Sales Invoices History 

Page Seminar 
Registers 

Seminar Registers History 

Page Navigate Navigate History 

j. Under the Setup group, create the following items. 

Object ID Caption Department 

Page Seminar Setup Seminar Setup Administration 

k. Save the MenuSuite object. 
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Module Review 
Module Review and Takeaways 

RoleTailored clients for Microsoft Dynamics NAV 2013 give users Role Centers that 
increase user productivity. It enables users to focus on their most important tasks 
and locate information quickly and efficiently without spending unnecessary time 
on a complex user interface. 

A Role Center typically includes the following: 

• An Activities part 

• Several lists that enable users to select their favorite records, such as 
customers or items 

• Several system parts, such as Outlook or My Notifications.  

The Activities part contains several groups of cues that are defined as flow fields in 
the Activities page source table. 

The Role Center also defines the contents of the navigation pane that is visible 
and available on every list place or department page. It also defines the contents 
of the ribbon when users click the Role Center item in the Home menu. 

Even though the Role Center is the most important feature that increases 
productivity based on user role, you must always provide a department page for 
any application area that you develop. This guarantees that the users can use the 
Departments page to manually browse to your custom application area 
functionality, and that all the pages that you create for a new application area can 
be accessed from the Search field. 

Test Your Knowledge 

Test your knowledge with the following questions. 

1. Which page type do you use to define role centers for profiles in Microsoft 
Dynamics NAV 2013? 
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2. Which control type do you use to show stacks of documents called cues? 

What type of control must be the parent? 

 

 

 

 

3. What kind of data is contained in fields shown by cues? 

 

 

 

 

4. How do you add new menus to the Navigation pane of the RoleTailored 
client? 

 

 

 

 

5. Role center pages are data bound. 

(   ) True 

(   ) False 

6. An action in role center page can contain code in the OnAction trigger. This 
code executes when the user clicks the action. 

(   ) True 

(   ) False 
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Test Your Knowledge Solutions 

Module Review and Takeaways 

1. Which page type do you use to define role centers for profiles in Microsoft 
Dynamics NAV 2013? 

MODEL ANSWER: 

RoleCenter 

2. Which control type do you use to show stacks of documents called cues? 
What type of control must be the parent? 

MODEL ANSWER: 

Use Field controls within CueGroup controls to show cues. 

3. What kind of data is contained in fields shown by cues? 

MODEL ANSWER: 

To show as cues, fields must be of integer type. Typically, they are FlowFields 
with Count calculation type. 

4. How do you add new menus to the Navigation pane of the RoleTailored 
client? 

MODEL ANSWER: 

For each new menu, define the ActivityButtons action container. 

5. Role center pages are data bound. 

(   ) True 

(√) False 

6. An action in role center page can contain code in the OnAction trigger. This 
code executes when the user clicks the action. 

(   ) True 

(√) False 
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